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Software License Agreement

Carefully read the following terms and conditions.

This is a legal agreement between you, the end user (either an individual or an
entity), and Scanvec Amiable, Inc. If you do not agree with the following, you
should promptly return the package. Use of this program indicates your acceptance
of the terms and conditions stated below.

The enclosed computer program "Software" is licensed, not sold, to you by
Scanvec Amiable, Inc., for use on a non-exclusive, non-transferable basis, only
under the following terms, and Scanvec Amiable, Inc., reserves any rights not
expressly granted to you. You may not disclose to any third party any confidential
information concerning the Software or Scanvec Amiable, Inc. or use such
confidential information to the detriment of Scanvec Amiable, Inc...

1. License.

This software is protected by the United States Copyright Law and International
Treaty Provisions. Therefore, you must treat the Software just as you would any
other copyrighted material, such as a book. This license allows you to:

(a) Make one copy of the Software in machine readable form; provided that
such a copy of the original may be used solely for backup purposes. As an
express condition of this License, you must reproduce on each copy of the
Scanvec Amiable, Inc., copyright notice and any other proprietary legends on
the original copy supplied by Scanvec Amiable, Inc.

(b) Transfer the Software and all rights under this License to another party
together with a copy of this License and all written materials accompanying
the Software provided you give Scanvec Amiable, Inc., written notice of the
transfer and the other party reads and agrees to accept the terms and
conditions of this License.

(c) Use this Software on a single computer only, but may transfer it to
another computer as long as it is used on only one computer at a time. “In
Use” constitutes being loaded onto either temporary (i.e., RAM) or
permanent memory (e.g., hard disk, CD-ROM or other storage device) of a
computer.

2. Restrictions.

You may NOT distribute copies of the Software to others or electronically transfer
the Software from one computer to another over a network. You may not de-
compile, reverse engineer, disassemble or otherwise reduce the Software to a
human perceivable form. You may not modify, adapt, transfer, rent, lease, loan,
resell for profit, distribute, network or create derivative works based upon the
software or any part thereof.

3. Termination.

This License is effective until terminated. This License will terminate immediately if
you fail to comply with any of its provisions. Upon termination, you must return the
Software, and all copies thereof, to Scanvec Amiable, Inc., and you may terminate
this License at any time by doing so.

© 2014 Graphtec Corp.

4. Export Law Assurances.

You agree that neither the Software nor any direct product thereof will be
transferred or exported, directly or indirectly, into any country prohibited by the
United States Export Administration Act or any international export laws and the
restrictions and regulations thereunder, nor will it be used for any purposes
prohibited by the Act or laws.

5. Warranty Disclaimer, Limitation of Remedies and Damages.

In no event will Scanvec Amiable, Inc., be liable for any damages, including
infringement, lost data, lost profits, cost of cover or other special, incidental,
consequential or indirect damages arising from the use of the program however
caused and on any theory of liability. This limitation will apply even if Scanvec
Amiable, Inc., or an authorized dealer or distributor has been advised of the
possibility of such damage. SCANVEC AMIABLE, Inc. MAKES NO WARRANTY,
EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, AND
DISCLAIMS, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF
MERCHANTIBILITY OR FITNESS FOR A PARTICULAR PURPOSE. Scanvec
Amiable, Inc., does not warrant any drivers for plotting, scanning or either devices.
These drivers are provided for our customers as a service only, and were
developed using information provided to us at the time by the equipment
manufacturers.

Scanvec Amiable, Inc., is not responsible for any typographical errors in the
software or in the documentation.

6. General.

If you are a U.S. Government end-user, this License of the Software conveys only
"RESTRICTED RIGHTS," and its use, disclosure, and duplication are subject to
Federal Acquisition Regulations, 52.227-7013(c)(1)(ii). This License will be
construed under the laws of the State of Pennsylvania, except for that body of law
dealing with conflicts of law, if obtained in the U.S., or the laws of jurisdiction where
obtained, if obtained outside the U.S. If any provision of this License is held by a
court of competent jurisdiction to be contrary to law, that provision of this License
will remain in full force and effect.

© Copyright 2014 by Scanvec Amiable, Inc. All rights reserved. No part of this
publication may be reproduced, stored in a retrieval system or transmitted, in any
form or by any means, electronic, mechanical, photocopy, recording or otherwise,
without the prior written permission of the publisher. Printed in the United States of
America. The information in this manual is subject to change without notice and
does not represent a commitment on the part of Scanvec Amiable, Inc.

Acrobat® Reader Copyright© 1987-2014 Adobe Systems Incorporated. All rights
reserved. Adobe and Acrobat are trademarks of Adobe Systems Incorporated
which may be registered in certain jurisdictions. PostScript® software Copyright©
1984-1998 Adobe Systems Incorporated. All rights reserved.

Flexi, FlexiFAMILY, FlexiSIGN-Pro, FlexiSIGN Plus, FIexiEXPERT, FlexiSIGN,
FlexiLETTER, FlexiDESIGNER, FlexiCUT, FIexiENGRAVE, PhotoPRINT Server,
PhotoPRINT, PhotoPRINT SE, EnRoute-Pro, EnRoute Plus, EnRoute, EnRoute-
Machine Shop, and/or other Scanvec Amiable products referenced herein are



either trademarks or registered trademarks of Scanvec Amiable, Inc. lllustrator is a
registered trademark of Adobe Systems Incorporated. FreeHand is a registered
trademark of Macromedia Corporation. CoreIDRAW! is a trademark of Corel
Systems Corporation. AppleTalk, ImageWriter, LaserWriter, and Macintosh are
registered trademarks of Apple Computer, Inc. Windows is a registered trademark
of Microsoft Corporation. The names of actual companies and products mentioned
herein may be the trademarks and/or registered trademarks of their respective
owners. Adobe® is a trademark of Adobe Systems Incorporated or its subsidiaries
and may be registered in certain jurisdictions. PostScript® is a trademark of Adobe
Systems Incorporated or its subsidiaries and may be registered in certain
jurisdictions.

SA International
PO Box 16109
Salt Lake City, UT 84107 USA
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Introduction

Cutting Master 2 for CraftROBO is a program that allows you to

output directly from your design application to a cutter. Installing Visual Basic for Applications (VBA) for

CorelDRAW 10
VBA automatically installs for CoreIDRAW 11, 12, X3, X4, X5

It consists of two parts:

e The Cut/Plot plug-in that allows you to set job properties for X6 and X7.
the cut job from within your design application and sends the _ o )
job to Cutting Master 2 for CraftROBO. When you install CoreID_RAW .10 through the typlqal |nstallat|or_1,
_ ] VBA does not automatically install. You must install VBA in
e The Cutting Master 2 for CraftROBO program that receives order to run the Cut/Plot feature of your software.

the job from the Cut/Plot plug-in and outputs it to the cutter. _
If you need to install CoreIDRAW and VBA:

Using the Software 1. When installing CoreIDRAW, select Custom Setup.

2. From the list of components, select Visual Basic for
Applications 6.0 & IE 5.

3. Continue with regular installation.

To send a job to a cutter using Cutting Master 2 for CraftROBO:
Create the job in the design application.
If desired, add registration marks to your design.
Open the Cut/Plot dialog.

1

2 If you need to install VBA only:
3

4. Adjust the job properties in the Cut/Plot dialog.

5

6

4. |nsert the CoreIDRAW CD.

5. From the Corel Setup Wizard, select Add New
Send the job to Cutting Master 2 for CraftROBO. Components.

Use Cutting Master 2 for CraftROBO to output the job to the 6. From the list of components, select Visual Basic for
cutter. Applications 6.0 & IE 5.

Supported Applications

On Windows, Cutting Master 2 for CraftROBO supports the
following design applications:

e Corel CorelDRAW 10, 11, 12, X3, X4, X5, X6, X7

e Adobe lllustrator 8, 9, 10, CS, CS2, CS3, CS4, CS5, CS6,
CC, CC2014

On Macintosh OS X, Cutting Master 2 for CraftROBO supports
the following design applications:

e Adobe lllustrator 10, CS, CS2, CS3, CS4, CS5, CS6, CC,
CC2014

© 2014 Graphtec Corp. 1



Installation and Setup

Before you begin installing the software, read the hardware

requirements below. For optimal performance we suggest that Installing the Software (Windows)

your system meet the recommended requirements. As with all Full access rights are required to install this software.
computer software, systems with faster processors, more RAM, Be sure to log on to Windows as an administrator account
and greater amounts of storage space allow you to work with member.

larger fil nd k rpr ing time to a minimum. . .
arger files and keep your processing time to a minimu To install Cutting Master 2 for CraftROBO:

Recommended System Requirements 1. Uninstall any previous version of the software.
Insert the Installation CD.

Windows Macintosh

Pentium Il 600 MHz or
greater (32bit)

2
3. Select a language and then click OK.
4

Select the product and language to be installed and then

Processor G4,G5,Intel CPU . i
1GHz or greater 64bit (x64) click Next.
processor 5. On the Welcome screen, click Next.
RAM 1GB or greater 6. Read the Software License Agreement and click Yes to
Install Space 200MB or greater accept.
Operating Windows 8, 7,Vista, XP, 7. Select the components of the software that you want to
System 2000 0SX10.4 or greater install. You may also change the folder the software will be
installed into. Click Next.
. 800x600 resolution monitor 1024x768 resolution
Video with 16 bit color or greater | monitor with 24 bit color 8. Select the Start menu folder where the shortcu'_[ for the
: software will appear. By default, a new folder will be created
4x CD-ROM or DVD Drive for the product. Click Next.
Other Available Port for Output Device 9. Select whether additional shortcuts for the software will be
Internet Connection created:
a. Check Install to desktop to install a shortcut for the
Before You Install the Software software on the desktop_p
Before you install the software, you should do the following: b. Click Next.
¢ Install all of your design applications. 10. Click Next to begin installing the software.
e Install any additional drivers that are necessary for your 11. If you have Adobe lllustrator installed, you will be prompted
cutters, such as USB drivers. for the location of the Plug-ins folder for each version of

. Illustrator you have installed.
e Set your cutter to operate in GPGL mode. See your cutter y

documentation for details. a. If necessary, click Browse and select the folder location.

© 2014 Graphtec Corp. 2



12. Click Yes to clear the preferences. Uninstalling the Software (Macintosh)

13. Select Finish. 1. Exit Cutting Master 2 for CraftROBO by selecting Quit from
: . i the application menu.
Uninstalling the Software (Windows)

1. Exit Cutting Master 2 for CraftROBO by selecting Exit from
File menu.

In the Cutting Master folder, double-click Uninstall.
3. Click OK.

2. In the Windows Control Panel, double-click the Add or Creating an Output Device Setup

Remove Programs icon. i ) .
The first time that you run Cutting Master 2 for CraftROBO, you

3. Select Cutting Master 2 for CraftROBO from the list and will be prompted to create an output device setup. See
click the Change/Remove button. “Creating an Output Device Setup in Cutting Master 2 for

In the Welcome screen, select Remove and click Next. CraftROBO” page 12 for details.

Click Yes to uninstall the software. .
Using Preference Manager

Installing the Software (Macintosh)
Full access rights are required to install this software. Corel D e s
Be sure to log on to Mac OSX as an administrator account : Save. ]

Standard 5 etups

member. Delete |

Follow these steps to install the software:
1. Insert the Installation CD.

i A Load |
Double click the Installer icon. |

2

3. Select a language and then click OK.

4 Preference Manager is a utility that allows you to save all of the
settings in the software to a file, including all output device

setups and all application preferences.

Select the product and language to be installed and then
click OK.

Read the Software License Agreement and click Accept. You cannot load a set of preferences while either the design
Click Next. software or Cutting Master 2 for CraftROBO is running. You can

Select the Install Location and click Install. save preferences at any time.

Click Stop to halt installation. SaVing a Set of Preferences
8. Click Yes to clear the preferences. To save the current set of preferences to a file:
9. Click OK. 1. Run Preference Manager.
10. Click Quit. 2. Click Save.

© 2014 Graphtec Corp. 3



()8 I Cancel |

3. Type the name for the set of preferences in the field and
click OK.

Loading a Set of Preferences
To reload a previously saved set of preferences:
1. Exit the software.
2. Run Preference Manager.
3. Select the set of preferences you want to load.
4. Click Load.

Restoring the Software to its Original State.

The default settings for the software are stored in the Factory
Defaults set of preferences. Restoring the software to its default
state may be particularly helpful when troubleshooting any
problems you may encounter with Cutting Master 2 for
CraftROBO.

Loading this set of preferences will remove the output device setup in Cutting
Master 2 for CraftROBO.

To clear the preferences stored in your system:
1. Exit the software.

2. Run Preference Manager.

3. Select Factory Defaults.

4. Click Load.

Exiting Preference Manager

To exit Preference Manager, click EXxit.

© 2014 Graphtec Corp.



Creating the Job in the Design Application

The first step in outputting a job using Cutting Master 2 for
CraftROBO is to create the job in your design application.

Guidelines for Creating Your Design

When creating a job, remember the following guidelines:

Convert all bitmap graphics into vector objects. Cutting
Master 2 for CraftROBO can only output vector objects.

Objects cannot have patterned fills, bitmap fills, lens effects,
gradients, or other custom fill types. Any objects with these
fill types will be ignored by Cutting Master 2 for CraftROBO,
and will not appear in the Cut/Plot dialog.

Use colors or layers to separate objects that you want to
output at different times. You can then use the Layering tab
of the Cut/Plot dialog to choose which colors or layers will
be output.

There is no need to make duplicate copies of your design in
the design application. Cutting Master 2 for CraftROBO can
easily output duplicates of any design, and can even place
multiple copies on the same page.

Don’t worry about objects of the same color that overlap.
The Auto-Weld feature can automatically merge overlapping
objects together.

If you need to make multiple cutting passes, you can select
the number of passes in the Advanced tab of the Cut/Plot
dialog. There is no need to stack up multiple copies of an
object to force multiple cutting passes.

© 2014 Graphtec Corp.

Accessing the Cut/Plot Dialog

Once you have created your job, the next step is to open the
Cut/Plot dialog.

To access the Cutting Master 2 for CraftROBO Cut/Plot dialog:

If you are using Adobe lllustrator, from the File menu, select
Cutting Master 2 for CraftROBO then Cut/Plot.

If you are using CorelDRAW, select Cut/Plot from the Corel
Application Launcher. The Corel Application Launcher is a
list in the standard toolbar that lets you launch other
applications from within CoreIDRAW. It uses the following
icons, depending on your version of CorelDraw:

£ CoreDRAW 10 [}, CoreDRAW 12 & X3
sz CorelDRAW 11 X CoreDRAW X4, X5, X6 & X7

(o
CraftROBO cc100-20@Graph [ status |
Properties.. L
wopers.. | 1 ,| ijﬂ
&le|w |
- Media size ] 8 g & S 4 22 1 )
[User defined =l e
& 5000 = 30 oo = A
e — ol | |
3 % Fee o4 1 |
= - = ol | |
" ¥ | Propzitional af i
 Position ]
(¢ [0.000n = F Jooon = of
=) = F |
I~ Gelestion only i
|
™ Use document origin al
Reset .
[W G =|®| Tomlsz=:  850mx825n Send Dore




Entering Numerical Values Simple Arithmetic Operators

If you enter a simple arithmetic expression, the software will

Cutting Master 2 for CraftROBO supports a number of unique . .
g PP g calculate the result of the expression and enter that value in the

features that make it easier to enter numerical values.

field.
Using Built-In Mathematical Operations The available arithmetic operators, in order of precedence, are:
The software is able to perform a number of calculations /| Division
whenever a numerical value is being entered. « | Multiplication
Automatic Unit Conversion + | Addition
If you enter a value using a different unit of measurement than - | Subtraction

the default unit, the software will automatically convert the value i .
to the default unit. For example, if you enter 1/8, the value 0.125 will be calculated.
Operator precedence determines the order in which the
arithmetic operations will be calculated when more than one
) operation is specified. In the previous list, operators are listed
Supported units are: from top to bottom in order of operator precedence. For instance,

if you enter 6/2*3, the software will calculate 6/2 first then

multiply the result by 3, yielding a result of 9.

For instance, if your default unit is inches, you can enter a value
of 1 ft, and the software will convert the measurement to 12 in.

in," | inch
ft,"  foot
Automatic Application of Entered Values and
Arithmetic

Once you enter a numerical value, ratio, or arithmetic

expression in a numerical field, the software will automatically
pt point apply that value after a brief delay.

mm | millimeter
cm centimeter

m meter

Calculation of Ratios

If you enter a ratio in the format A:B, the software will scale the
previous value in the field by the ratio entered.

For instance, if a value is set to 12, and you enter 2:3, the new
value will be 8.
Calculation of Percentages

If you enter a percentage in the format X%, the software will
scale the previous value in the field by the percentage entered.

For instance, if a value is set to 10, and you enter 90%, the new
value will be 9.

© 2014 Graphtec Corp. 6



Setting Job Properties Setting General Tab Properties

The following controls are available on all tabs of the Cut/Plot The General tab allows you to specify the size of media, size of

the job and the location of your output on the media.

dialog:
= Cut/Plot =101 x|
Properties  Click to adjust the setup properties. See “Editing Output el = st '
Device Settings” page 14 for details. ﬁl WEII 5
EI Click to start Cutting Master 2 for CraftROBO. Meda e T & 7 © & & 5 & a o
IUserdeﬁned j E
I h Click to select the Select tool. (This tool is selected by = CE= (R (T | e
default most of the time) e g i
: . . . wfmd % EE— 2 |
Ell Click to select the Zoom tool. Click and drag in the job R i I |
preview pane to select an area of the design to zoom in on. S T (1 T b |
For Windows, hold the CTRL key and click to zoom out. For Ll 2 e E
Macintosh, hold the Option key and click to zoom out. Postion .
(¢ [0.000n = F Joooon = of
= | Click to select Zoom to Width. The preview pane will g0 o= F )
automatically zoom in or out so that the entire width of the |
media is displayed. P 3 b
Ql Click to select Zoom to All Objects. The preview window W (i ,, =
will zoom in or out so that all of the objects in the design are i e 56
. E i
displayed. = ) SN
Reset Click to return job properties to their default settings. N
Send Send the job to Cutting Master 2 for CraftROBO with the [% Q2@ Todse  250nxe26n Send Done
current settings.
Done Close the Cut/Plot dialog and return to the design The following settings are available:

application.

© 2014 Graphtec Corp.

Media The size of the media loaded into your output device. Select
Size from one of the preset sizes, or specify unique dimensions
below.
=[] The width and height of the media. When a set of
unique dimensions is specified, it is automatically
added to the list of preset sizes.
Job Size Choosing one of these options allows you change the output

size and orientation of the page.

=] The job's width and height.

‘975' 19 The job's width and height as a percentage
of the original.

Fit to Media Scales the job proportionally so that it is as

large as possible while still fitting within the
cuttable area of the output media.



Position

Selection
Only

Use
document
origin

Proportional ~ When this option is selected, the height and
width of the job are increased or decreased
together to keep the original proportions

intact.

These settings change the position of the job on the media.

o+ F

The distance between the job and the right and
bottom margins of the cuttable area. You can
also change these settings by dragging the job
across the page in the preview pane.

i’l Interactive: moves the cutter as you change
the position of the job on the preview area.

El Show me: draws a bounding box of the job
without lowering the tool.

ﬂ Places the job at the specified distances from
* the lower and right edges of the cuttable area of
the output media.

ﬂ Places the job at the specified distances from
* the lower and left edges of the cuttable area of
the output media.

YO Centers the job along the width of the cuttable
* area.
+LI4 Centers the job in the middle of the cuttable

area. Only available for sheet material.

Rotates the image on the media in 90-degree
increments. Click the button until you achieve
the desired orientation.

Flips the selected image on the vertical axis, so
that your image will be mirrored when output.

Output only the selected objects, not the entire design. This
option is enabled if you had objects selected when you
opened the dialog.

If not checked, left bottom point of the bounding box of
selected objects becomes origin of plotter. If checked,
document origin of Illustrator or CorelDRAW becomes origin
of plotter. Positions of objects from document origin are kept
positions from the plotter origin.

Note: Document origin of lllustrator or CoreIDRAW is the
point (0,0) of the ruler.

© 2014 Graphtec Corp.

Setting Layering Tab Properties

The layering tab allows you to assign different cutting
parameters to different color or layers in your cutting job. You
can cut one color slower than another color, for instance.
‘s Cut/Plot I [
CraftROBO cc300-20@Graph Job Status |
Properties... EI J_"'['j
g ® |79 | J
@ Bycolor " Bylayer 8 i 8 5 4 = 2 Kl ,‘0|‘|
Color/Laye: Setting - :_ : ‘
v . R255 G255 B255 CraftROBO cc300-20
v [ ROGO B255 CraftROBO cc300-20 2| J
|7 . R127G255 B0 CraftROBO cc300-20
|7 R255 G0 B127 CraftROBO cc300-20 o
[v [ |R2s5 G255 6O CraftROBO 6c300-20 [l [‘“J
|7 ROG127 B255 CraftROBO cc300-20 & el .:ig
T T | i
O e e E I
= =——x
™| Single setting for &l wf
Proset: [Bond Paper 1328 bs = e ==
Speed: |':~'.: = Force |?Z = e
o _
Line type: |1 j Pitch size: IZ-:::' j‘ o b"
Test cut: @I _ [_“ AN
Passes: m | o |
™| Platter contraller Reset j ZI

[ & =& T

size: 10.31in x 22.49n Send

Done

The following settings are available:

By color/
By layer

Orders your output by color, or by layer. “Layer” refers to
layers in the design application, not overlapping layers of
vinyl.

o If you choose By color, all objects with the same color will
be cut at the same time, unless Pause between
colors/layers is checked. If you have overlapping objects
of the same color, you will get overlapping contour cuts.

o If you chose By layer, the job will be cut one layer at a
time. All objects in each layer will be cut at once, unless
Pause between colors/layers is checked. If you have
overlapping objects in a layer, you will get overlapping
contour cuts.



Pause
between
colors/
layers

Enable
driver
options

If checked, output will be paused between colors or layers. Line
This allows you to load different colored vinyl into your Type
cutter.

If cleared, the job will be sent as a single layer. The Single
setting for all option will automatically be checked, and
identical driver options will be used for the entire job. If
weedlines are enabled, there will only be a single set of
weedlines for the entire job.

Check to set the following options in the software. If this
option is not checked, the settings on the output device will
be used instead.

Settings can be set individually for each color or layer by

selecting the color or layer in the list then setting the options )

below (but see Single setting for all). P!tCh
. Size

Single

setting

for all

If this option is checked, identical driver options

will be used for all colors or layers. @l

If Pause between colors/layers is not
checked, Single setting for all is automatically
checked, and may not be cleared. This is
because the job is automatically sent as a
single layer when Pause between
colors/layers is not checked.

Preset Plotter

Driver option presets allow you to save all of the
driver options for a common type of job and
reapply them in a single step. See “Working

with Driver Option Presets” below, for details.

Test Cut

Passes

Select the line type.

The following line types are provided as
standard:

You can also edit three custom line types. See
“Editing Custom Line Types” page 10 for
details.

The length it takes for the line pattern to repeat
when a line type other than solid is selected.

Allows you to output test cutting jobs to
appropriate output devices, to make sure
everything is functioning properly.

Defines the number of times that the blade will
cut the same path. Set this option if you are
using thick or hard media that can’t be cutin a
single pass.

If checked, Cutting Master 2 for CraftROBO will send the

Controller current job to the Graphtec Plotter Controller application for
output when the Send button is clicked. This option is only
enabled if the setup is for a device that is supported by the

Plotter Controller application. The device setup must use a

Speed Speed at which the cutting head or pen moves

across the media.
Set to O to use the setting on the cutter.

Force The amount of downwards force applied to the
cutting head or pen.

USB connection. If Plotter Controller is not installed, this
option will be disabled. See the Plotter Controller
documentation for details on outputting jobs from that
application.

When this option is checked, the following fields in the

cut/plot dialog will be disabled:

Set to O to use the setting on the cutter.

¢ Job width
¢ Job height

e Percent width

¢ Percent height

¢ Fit to media

* Proportional
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¢ Use registration marks

In addition, the Rotation control will be limited to the 0 and
90 degrees counterclockwise settings. ﬂ ﬂ

Working with Driver Option Presets
Driver option presets allow you to save all of the driver options
for a common type of job and reapply them in a single step.
Creating Presets
To save the current driver options as a new preset:
1. From the Preset list, select Save as.

()8 I Cancel |

2. Enter a name for the new preset.
3. Click OK.

Updating Presets

To update the currently selected preset with the currently
selected driver options, from the Preset list, select Save.
Applying a Preset

To apply the driver options saved in a preset to the current job,
select the preset from the Preset list.

Renaming a Preset

To rename a preset:

1. Select the preset you want to rename from the Preset list.

2. Select the Rename command from the Preset list.

3. Type in the new name and press OK.
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Deleting a Preset
To delete a preset:
1. Select the preset you want to delete from the Preset list.
2. Select the Delete command from the Preset list.
dl Do you really want ko delete the preset?

es Mo |

3. Click Yes.

Editing Custom Line Types
To edit the custom line types:
1. Select Edit from the Line Type list.

a b ®
Custom 1: ID.D24in ::|I ID.DDSin ﬁ a b a b a b
Custom2: |0000n =4 [0000in =5 /00000 = T LThTLE E bThETL I
Custom3: [0.000n =000 =|0000n = =BT 3 bTH 3 b

()8 I Cancel |

2. Specify the three custom line types by listing the lengths of
the line segments and spaces that make up the line:
a The length of the first segment in the line.
The length of the space between line segments.

¢ The length of the second and third line segments, if any. Custom
1 is made up of one repeating line segment, while Custom 2 has
two segments that repeat in a pattern, and Custom 3 has three.

3. Click OK.
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Setting Advanced Tab Properties Sending Jobs to Cutting Master 2 for CraftROBO

The Advanced tab allows you to set several options specific to

cutting jobs. To send the current job to Cutting Master 2 for CraftROBO for

output, click the Send button in the Cut/Plot dialog. To exit the

i — I =Lal] Cut/Plot dialog, click Done.
ﬂ'gfi"l "G—, f Once sent to Cutting Master 2 for CraftROBO, the job will
al — immediately be output, unless the Hold in List option on the
I Ao wod W e |2 ' General tab of the Cut/Plot dialog is checked. If Hold in List is
4 checked, the job must be output manually. See “Outputting Jobs
s e ] i | from Cutting Master 2 for CraftROBO” page 15 for details.
: | Once output, the job will either be deleted, or held in the queue,
i | depending on the After Output setting in the Advanced tab of
N the Cut/Plot dialog. See “Setting Advanced Tab Properties”
o page 11 for details.
[% & &|®| Tows=  esinxszsn Send Done
The following settings are available:
Auto-weld Removes overlapping areas of objects that have the
same color.
Convert Selects whether the strokes will be cut separately as an
strokes to object.
outlines
Units Specifies the units that will be used for measurements.
Use Can be used to align a contour cut with the printed
Registration output.
Marks
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Outputting Jobs from Cutting Master 2 for CraftROBO

Basic Elements of Cutting Master 2 for CraftROBO

The following are the basic elements of Cutting Master 2 for
CraftROBO:

I [ [Of %]

File Edit Setup View Help

Toolbar ——

Job Mame | Skatus Copies | File tvpe | Color
Snowflakes, job Holding 1 Cut job Multiple

CovokeCarehos, .,

Job
Area

ol |

|RAM: 1007 ME 631 ME free ¥IM:2179 ME free 1143611 MB free D:147157 ME free

A

Column Headings

Note the column headings in the job area:

Job Name  The file name of the job.
Status The current status of the job.
Copies The number of copies to be output.
File Type The type of job.
Color The color specified for the material. If multiple colors are
specified, this field will read Multiple.
Toolbar

A toolbar is located at the top of the main window. It contains
tools for the most commonly used functions.

To show or hide a toolbar, select Toolbar from the View menu.

The toolbar functions are:

] Add Job

Save As

Adds a job to the selected output device.

Saves the selected job to a file.

© 2014 Graphtec Corp.

'-jl Send Job  Sends the selected job to the output device.

Stops selected file from being output.

Deletes the selected job or jobs.

ﬁ Delete

Setting Application Preferences

To set application preferences, from the Edit menu select
Preferences.

Urits:

Precision: I 0.000 - l

Reset | ()8 I Cancel |

The following settings are available:

Units The units of measurement displayed.

Precision The degree of precision to use with measurements.
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Creating an Output Device Setup in Cutting Master
2 for CraftROBO

The output device setup provides the link between the software
and your output device. It contains the following information:

o The type of output device being used.

¢ The method used to communicate with the device.

Creating Your First Output Device Setup

When you start the software for the first time, you are prompted
to create your first output device setup:

x
Click the manufacturer and model of your setup.
Manufacturer: Model name:
Graphtec GPGL CraftROBO cc100-20
CraftROBC cc200-20
CraftROBO cc300-20
CraftROBC cc300L-20
CraftROBO cc330-20
CraftROBO cc330L-20
< Back Next > Cancel |

1. Select the Manufacturer and Model Name of the output
device from the list.

2. Click Next.

© 2014 Graphtec Corp.

Change Setup =

Setup name: | CraftROB0 oc100-20_1]

< Back I Mest > I Cancel

Edit the Setup name of the device.
Click Next.
x|

Port: IGraphtec UsE j

< Back Cancel |

Select the Port the output device uses for communication. If
necessary, edit the communications settings for the chosen
port.

Click Finish.
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Changing the Output Device Setup

The software allows only one output device setup to be in use at
any given time. Creating a new setup will eliminate the existing
one.

To change the output device setup, from the Setup menu,
select Change Setup.

The steps to create the new setup are the same as the ones for
the original setup.
Editing Output Device Settings

To edit the properties associated with the output device setup,
from the Setup menu, select Setup Properties.

Job Workflow Tab )

& |2 |
The Job Workflow tab
disp|ays information about Setup name: | RGNS
the output device.

Reset |
Apply | oK I Cancel |

Setup name Name of the setup.

© 2014 Graphtec Corp.

Communication Tab =

The Settings section of this
tab changes depending on
the port used to connect to
the output device.

Ports are listed in order of
popularity for each device.
Only the ports that are
usable by the output device
are listed.

The standard port for the
device is selected by
default. Some of the port
settings may still need to be
entered or edited, however.

| ()8 I Cancel |

Port  Select the port to which the cutter is connected. The port list is
limited to the ports that are actually present on your computer and

usable with your output device.

USB USB drivers are provided with output devices that
support them. Please make sure the proper drivers are

installed when using these ports.

14



Outputting a Test Cut Job

The software allows you to output test cutting jobs to
appropriate output devices, to make sure everything is
functioning properly.

To output a test cut job, from the Setup menu, select Test Cut.

Outputting Jobs from Cutting Master 2 for
CraftROBO

Saving a Job to a File
To save a job to a .PLT file, do one of the following:
e Select the job and from the File menu, select Save As.

e Select the job, then click on the Save As button in the
toolbar.

e Right-click the job and select Save As from the context
menu.
Loading a Saved Job from a File
To load a previously-saved job from a file:
1. From the File menu, select Add Job.

[2]x]

Loakin: [ 5 Temp =l cEBEerE-

Snowflakez plt Add

¥ Preview
I~ Copy to job folder

Ll L«

Files of type: [0l Readable
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Select the file to be added.

If you want to copy the file to the local job folder, check
Copy to job folder.

If the job is on removable media or a network drive, copying it to a local folder
will allow you to process the job after removing the media or disconnecting
from the network.

4. Click Add.

Sending Jobs to the Cutter
To send a job to the cutter, do one of the following:
e Select the job and from the File menu, select Send.
e Select the job, then click on the Send button in the toolbar.

¢ Right-click the job and select Send from the context menu.

Aborting the Processing of a Job

To abort the processing of a job while it is being cut, do one of
the following:

e Select the job and from the File menu, select Abort.
e Select the job, then click on the Abort button in the toolbar.
¢ Right-click the job, then select Abort from the context menu.

If a job is aborted while being output, its status freezes at 0%.

Deleting Jobs
To delete a job, do one of the following:

e Select the job and press the Delete or Backspace key on
your keyboard.

e Select the job and from the Edit menu, select Delete.
e Select the job, then click on the Delete button in the toolbar.

e Right-click the job, then select Delete from the context menu.
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Cutting Master 2 for CraftROBO allows you to use a cutter to cut
a contour on printed output generated on a separate printer.
This produces output similar to that of a hybrid printer/cutter
device.

In order to cut a contour on a printed job, you need to do the
following:

1. Create the design for the job in your design application.

2. Add registration marks that will allow Cutting Master 2 for
CraftROBO to align the cut contour with the printed job.

Output the printed parts of your design.
Load the printed media into your cutter.

Output the contour part of your design on your cutter.

Designing a Job for Virtual Hybrid Output

When designing a job for virtual hybrid output, the most
important thing is that you should be able to separate the
printed parts of the job from the cut parts of the job.

This can be done in two ways:

e By placing printed and cut elements on separate layers and
then hiding the layers you do not want to output.

e By manually selecting the elements you want to print or cut,
and then printing or cutting only the selected elements.

Of these two methods, we recommend using separate layers to
isolate printed and cut elements, as this works much better with
complex designs.

© 2014 Graphtec Corp.

Contour Cutting Using Cutting Master 2 for CraftROBO

Adding Registration Marks to the Print Job

The Cutting Master 2 for CraftROBO plug-in allows you to add
registration marks to your design. These registration marks can
then be used to align a contour cut with the printed output.

The registration marks are added in their own separate, locked
layer of the design.

Do not change the name assigned to the layer containing the registration marks.

The registration marks must be printed out in order to be used
for automatic alignment of a contour cut. The marks themselves
will not be contour cut.

There are two ways to add registration marks to a design:
e Adding registration marks automatically.

e Adding a rectangle to the design and replacing it with
registration marks.

If the design is changed or resized after the registration marks are added, you will
need to remove the registration marks and add them again in order to properly
indicate the new size of the job. Registration marks do not automatically update
when a job is edited or resized.
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Adding Registration Marks Automatically

If no object is selected, Cutting Master 2 for CraftROBO will
automatically add registration marks around your design.

To add registration marks to your design:
1. Open your job in the design application.

2. Access the Registration Marks dialog using one of the
following methods:

e In Adobe lllustrator, from the File menu, select Cutting
Master 2 for CraftROBO then Registration marks.

e In CorelDRAW, select Registration Marks from the
Corel Application Launcher. The Corel Application
Launcher is a list in the standard toolbar that lets you
launch other applications from within CorelDRAW. It
uses the following icons, depending on your version of
CorelDraw:

£ CoreDRAW 10 f), CorelDRAW 12 & X3
sz CoreDRAW 11 = CoreDRAW X4, X5, X6 & X7

Registration Marks x|
-1
D Graphtec Type 2 Automatic
L 4
Urits: I Inches j
targin: ID.ESin 3:
Directior: I Harizartal j

[~ Conwvert rectangle

[ &lign document origin with registration marks
Total zize: 9.959in & 10.259in

Reset | ak I Cancel |

3. Select the desired registration mark from the topmost list.

[0 | None

B

I:l Graphtec Type 2 Automatic
L -
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4. Set the following options:

Units

Margin

Direction

Convert
Rectangle

Align document
origin with
registration
marks

Total size

5. Click OK.

The unit of measurement.

The distance between the registration marks and
the job.

If checked, Segment Area type marks will be
rotated 90 degrees

If checked, the registration marks will be placed
around the border of the selected rectangle. The
rectangle will then be deleted, leaving only the
registration marks.

If checked, left bottom point of the registration
marks becomes (0,0) point of ruler of lllustrator or
CorelDRAW. If add the registration marks without
check this check box, move the (0,0) point of ruler
to left bottom point of the registration marks
before send the job to cutter.

The dimensions of the area covered by both the
job and the registration marks together.

Replacing a Rectangle with Registration Marks

If a rectangle is created in the design application, and is
selected when the Registration Marks dialog is opened, Cutting
Master 2 for CraftROBO can use it as a bounding box for the
registration marks. The registration marks will be placed on the
border of the rectangle, and then the rectangle will be deleted,
leaving only the registration marks.

i
~m™

\

To replace a rectangle with registration marks:

1. Open your job in the design application.
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Draw the rectangle that you want to use as a bounding box.

Access the Registration Marks dialog (see previous
instructions).

Make sure the Convert Rectangle option is checked.
Set any other desired options (see previous instructions).
Click OK.

Removing Registration Marks

To remove the registration marks, do one of the following:

Repeat the procedure used to add the marks, but select
None.

Unlock and delete the layer that contains the registration
marks.

Outputting the Printed Parts of the Design

To output the printed parts of the design:

1.
2.

Hide the layer or layers which contain the contour cuts.

Make sure the layer or layers which contain the printed part
of the design are visible.

Use the standard printing function of the design application
to send the job to your printer.

Loading the Printed Media into Your Cutter

Once the printed parts of the job have been output, allow the ink
to dry (if necessary), then remove the media from the printer
and load it into your cutter.

Be sure to orient the printed media so that the registration
marks are not upside down, as this can cause problems.

© 2014 Graphtec Corp.

Load the media into the cutter then position the head over the
registration mark located at the top left corner when facing the
cutter.

Outputting the Contours to Your Cutter

To output the contour cut part of your design:

1. Hide the layer or layers that contain the printed part of your
design.

2. Make sure the layer or layers that contain the contour cuts
are visible.

3. Use the Cut/Plot dialog to send the output to Cutting Master
2 for CraftROBO.

4. Send the cut job to the cutter from Cutting Master 2 for
CraftROBO, if necessary.
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